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This document has the latest documentation about the DComplex IP Camera 
Viewer, an IP Cameras monitoring app.

Download IP Camera Viewer app from Apple App Store: 
http://itunes.apple.com/us/app/ip-camera-viewer/id412795760

IP Camera Viewer app is designed and developed by 
DComplex, LLC in New York, USA.

DComplex, LLC is a software development company focusing
on professional iPhone and Mac video surveillance solutions.

dcomplex.com

Information in this document is subject to change without notice. No part of this document may be reproduced or 
transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written 
permission of DComplex, LLC. 

The software described in this document is furnished under a license agreement and may only be used in accordance 
with the terms of that agreement.
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How to Prepare an IP Camera

Validating Access to Your IP Camera

Once you have an IP Camera setup on your network and running, verify that you 
can connect to it from your Mac.

For this, on your Mac,

• Open the Safari app and 

• Enter the address of your IP Camera. 

You should get the web page of the camera.

The camera's web page might need to install plug-ins to your browser to function 
properly in Safari. However, you do not need to install those in order for IP Camera 
Viewer app to work. If you see the camera home page in Safari, this is sufficient for  
the IP Camera Viewer app to access the camera.

If you do not see the camera home page in Safari, please see the instructions that 
came with the camera to make sure that the camera is configured properly and it  
the address of the camera is spelled correctly.

If the Safari app on your Mac cannot connect to your IP Camera, then the IP 
Camera Viewer app will not work as well. Ask your network administrator to 
allow access to the IP Camera from your Mac.
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Configuring Audio on Your IP Camera

IP Camera Viewer allows to hear audio from Axis and Panasonic IP Cameras. 
Before you can use audio in the app, you need to enable it in your Axis or 
Panasonic camera.

1. Connect to your camera using a Web Browser and find Settings.

2. In the Settings, select Audio section. Set the Enable Audio checkbox and 
save the settings.

3. Select desired audio properties. You have to select either G711 or G726 
as Encoding.

4. Update and save camera audio settings.
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Protecting Your IP Camera

In the default configuration, your username and password will be sent to the 
camera in clear text. 

We recommend to activate the Secure Sockets Layer (SSL, aka TLS, aka HTTPS) 
on the camera to protect the network traffic. Each cameras has a different 
procedure for it. Please see camera manual.
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How to Use IP Camera Viewer

The First Launch

When you launch the IP Camera Viewer app the first time, your screen will look like 
the following:  

The only operation available is Add Camera. 

IP Camera Viewer app provides you with several ways how to add a camera.

• Manually  : by using IP address,

• Automatically  : by using camera discovery mechanism.

If your camera is not yet integrated, you still can try to add it using one of Generic 
drivers.
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Adding a Camera

Invoke the Add Camera menu either by using

• the + button on the bottom-left corner of the app
or 

• the Camera menu on the top of the computer screen.

Then select one of the methods below.

Using Auto-Detection 

IP Camera Viewer can automatically discover many camera models.

Select Auto Detect menu to see all discovered cameras.

The following information will be shown for each found camera:

• Camera Name: It is typically set by manufacturer to show some info 
about the camera, such as model and MAC address. Once you add the 
camera, you will be able to modify the name that helps you to identify 
the camera.

• Manufacturer or model: In the screenshot above it is CNB and ONVIF.

• IP Address: The address is shown on the right through a drop down 
box. Some cameras might have multiple IP Addresses configured. In 
this case, use the drop down menu to select the address you wish to 
use. Often, any address would work just fine.

Select an IP camera from the list of detected cameras.

• Only one camera can be added at a time. For any additional cameras 
you will need to repeat the process.

• Some IP camera models can be additionally integrated through ONVIF 
protocol. In this case, the Auto-Detection window may show the 
camera the twice.

• The list will contain all detected cameras, even ones that you have 
already added to the app.
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Using Its Address 

If you know the Address of the camera and the camera model, you can add 
the camera manually. Typically you would use camera IP Address here. 
However, if your camera has less popular address format, such as DNS (like: 
mycam.dyndns.org), or local address (like: axis-a3.local.) - it would work as 
well.

Select the camera type from the drop down menu, such Axis, Sony or ONVIF.

Using Generic Drivers

IP Camera Viewer provides three Generic drivers for adding IP Cameras: 

• MJPEG Stream, 

• RTSP Stream and 

• ONVIF-Compatible IP Camera. 
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You can use any of them if your camera is not yet integrated.

• If your IP Camera is ONVIF-Compatible, make sure that the ONVIF 
mode is enabled on the camera (it is often disabled) and add the 
camera by just providing its IP Address, such as 192.168.1.100.

• Many IP Cameras can also stream video using RTSP or MJPEG 
Stream. You would need to find out the exact format of the RTSP or 
MJPEG Stream from your camera. It would look like this: 
rtsp://192.168.1.100/live or http://192.168.1.100/video.mjpeg.

Camera Preview

Setup the camera's connection parameters. Tap the Next button.

Note: You can import camera configuration here by tapping the Import 
Configuration from File button.

The app will attempt to connect to the camera to check what functionality is 
available. For example: whether the camera allows Pan Tilt and Zoom controls.
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The app will open the Preview tab to display live video from the camera. 

The camera has been added to the app Cameras list now. It is set up with default 
configuration.

You can always adjust camera configuration by tapping any accessible tabs on top 
of the configuration window and modifying the camera parameters. 

Switch back to the Preview tab anytime to see the changes take effect.

When you are ready, click the Add Camera button to confirm adding. 

At this point, you also can add camera to your video layout to be able to see live 
video from it.
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Configuring Camera

IP Camera Viewer allow you to modify your cameras' settings.

You can access the camera configuration through Edit Camera menu item from
• the Camera menu on the top of the computer screen 

or 
• the pop-up menu on the camera from Cameras list

or
• by using the button on the bottom-left corner of the app.

The camera configuration window looks like the following.

It has the following tabs:

• General  : contains connection parameters of the camera

• Video: contains quality parameters of the video stream

• Audio  : contains parameters of the audio stream

• Recording  : contains parameters for recording video

• Video Analytics  : contains parameters for detecting motion and faces and 
generating events

• Schedule  : contains parameters for continuous recording.
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Connection Settings (General)

Depending on the camera type, you will see the list of parameters that you can 
control.

• Name: Enter any name that helps you to identify the camera, such as “Front 
Entrance”.

• Address: Address of the camera. It is OK to use IP Address or a name, such 
as axis-a3.local. or me.dyndns.org. Do NOT enter http:// nor port number into 
the address field.
Note: Auto-Detect will automatically set the address of the camera for you.

• Port: Most cameras are configured to operate on port 80. If you changed it,  
select the appropriate port number.

• Protocol: Most cameras operate using http protocol, which is not secure. If 
you configured the camera to operate on https protocol, select it from the list.

• User Name and Password: if the camera allows access only to specific users, 
enter the credentials of the user.
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Video Recording and Analytics

IP Camera Viewer apps allows you to record video from an IP Camera 
automatically, either using schedule or record only events, or both.

To automatically record video from an IP Camera, set Activate Video Recording and 
Analytics item.

Note: Automatic video recording is initially available only for one camera.

• When you enable recording for additional cameras, the app will prompt you 
to purchase in-app item Recording Camera #2, Recording Camera #3 and 
etc.

• The app could record video from up to 5 cameras.

Video will be recorded to your Movies folder

• Video will be stored the specified number of days, if space permits.

• The app monitors your hard drive for free space. You can always see the 
current hard drive status in Storage window.
 

• If there is not enough space in the Movies folder, the oldest video recorded 
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by the app will be deleted automatically to free up space for newest video.

Note: if your hard drive is 90% full with system files or your other files, IP Camera 
Viewer will not record video automatically.

To record video when the motion or a face is detected, activate Motion Detection or 
Face Detection for the camera using the Video Analytics tab.

To record video continuously, select Record Continuously on Schedule item. 

• You could further adjust schedule for continuous recording using the Setup 
Schedule button.

Once you have activated video recording on the camera, you will see the camera's  
status in Cameras list as following.

Note: When your computer goes to sleep, video recording will NOT work. You must 
disable Mac sleep mode to be able to continue record video.
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Video Recording on Schedule

IP Camera Viewer apps allows you to record video from an IP Camera 
automatically using schedule. For this, activate Record Continuously on Schedule 
item. 

• Open Camera Settings window

• Select Recording tab 

• Check Record Continuously on Schedule item.

Notice that Setup Schedule button and Schedule tab become activated.

Now you can set up video recording based on the time of day and the day of the 
week. 

To access Schedule configuration window, select 

• the Setup Schedule button 
or 

• Schedule tab
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The Schedule configuration window will look something like the following.

Use your mouse to select time (in green) for continuous recording for each day of 
the week. 

You can reset the schedule to one of the pre-configured templates (Always, Never, 
Business Hours, Weekdays or Weekend) using Reset to combo-box.

After you Save your configuration, IP Camera Viewer apps will start recording video 
from the IP Camera automatically using the schedule.

Note: When your computer goes to sleep, the scheduled recording will NOT work. 
You must disable Mac sleep mode to be able to continue record video.
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Video Recording and Sleep Mode in Mac OSX

When your computer goes to sleep, the app will STOP video recording. That means 
that your scheduled recording will NOT work as well.

To learn more about what happens when your Mac goes to sleep read About 
Energy Saver sleep and idle modes in Mac OS X article.

Here is how to disable sleep mode on your Mac.

• Open the Finder app and select Applications item

• From it launch System Preferences app

• Select Energy Saver under Hardware section

• You will see two sliders

• If you set the Computer Sleep slider to Never - the computer will always stay 
on. 

• You could keep Display Sleep to some small value, like 5 minutes to save 
energy.
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Video Analytics

IP Camera Viewer app can continuously analyze video stream from configured IP 
Cameras to detect motion or detect faces. 

For the Motion Detection event, configure the Threshold to have the event triggered 
only when the amount of motion exceeds the value.

• The Motion Detection and Face Detection algorithms provide basic 
functionality at this time. They might occasionally generate events when there 
is no face in the camera or there is only irrelevant motion.

• Take some time to play with both video analytics events to understand how 
they can be used in your environment. When used correctly, the events can 
save you a lot of time during video search.

Once motion or a face is detected, the app will add the event to the Events list.

You can also record the video that triggered the event.

You can always search recorded video for events from a camera by using Video 
Search functionality.

Copyright © 2011-2012 DComplex, LLC           18



DComplex IP Camera Viewer User Manual

Audio

After you have activated audio and/or updated any audio setting in your IP Camera, 
you need to download new settings to the IP Camera Viewer app.

To activate audio in IP Camera Viewer

• Open Camera Settings window 

• Select Audio tab

• Select Audio check box

• Save new settings.

Now you should hear the sound from the camera.

If needed, go back to your camera and adjust camera mic sensitivity (Input Gain) to  
get the desired audio volume.
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Exporting Camera Configuration

IP Camera Viewer app allows you to copy camera configuration. Now you can add 
similar cameras faster.

Select the camera you want to copy from.

Invoke the Export Configuration menu by using the pop-up menu on the camera 
from Cameras list.
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Importing Camera Configuration

IP Camera Viewer app allows you to import any exported camera configuration 
while adding a camera.

To import an existing configuration to a new camera, 

• Tap the Import Configuration from File button, and 

• Select the file with the exported configuration.

Note: Video Recording and Analytics require you to purchase in-app item Recording 
Camera #2, Recording Camera #3 and etc. After you import camera configuration, 
make sure to set item Video Recording and Analytics as needed.
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Managing the Events List

IP Camera Viewer allows you to monitor Motion Detection and Face Detection 
events from any camera. 

To see the Events list, activate Show Events item from the Window menu.

Before you configure any events or after restarting the IP Camera Viewer, the 
Events list is empty.

Once motion or a face is detected, the app will display the event in its Events list in 
red.

After the event is restored, the Mac Client app will display the event name in black 
and show the total duration of the event.

Note: The number of items in the Events list is limited. However, you can still find all 
events from the camera in Video Search window.

In order to help you to see which portion of the image caused the event, the event's  
thumbnail image will have a red rectangle highlighting the region of the event.

You can always search recorded video for events from a camera by using Video 
Search functionality.
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Removing a Camera

You can easily remove a camera from IP Camera Viewer app.

Select the camera you want to remove.

Invoke the Remove Camera menu either by using

• the - button on the lower-left corner of the app
or 

• the Camera menu on the top of the screen
or

• the pop-up menu on the camera from Cameras list

Confirm removing.

The camera will be permanently removed from Cameras list. Any video cell from 
the camera will be closed.
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Monitoring Live Video
Monitoring live video will take the lion's share of your app use. Please review these 
tips to get familiar will all relevant features. You might find something that makes 
your experience much better.

Live Video

To watch live video from a camera

• Tap on the ▶ button in the middle of the camera video icon

Note: If there is no empty cells in your current layout, the camera will replace 
one of the displayed cameras.

Note: Each empty cell displays its order number.

or 
• Drag the camera from the Cameras list into the desired cell.

You should see the video from the camera now.
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Preferences

Video from each camera fills all of the cell's space. If the video from a camera is too 
wide or too high for the cell, it is automatically cropped to maximally fit in to the cell.  

To change cropping, 

• Access Preferences menu item from the IP Camera Viewer menu on the top 
of the computer screen 

• Change your preferences

• Tap the Close button.

All video windows will switch to the new mode of cropping.
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Layout Templates

IP Camera Viewer app comes with multiple layout templates. 

It can display video in 1x2 grid, 2x2 grid, 3x3 grid, 4x4 grid. It also allows you to 
create your own custom layout template. 

To change active layout template, use the Layout menu.

To create a custom layout template,

• Tap the Layout menu, and 

• Select Add Layout menu item.

• A new Add Layout configuration window will open.

• You can resize the Add Layout configuration window by tagging on its right 
corner.

• Enter a name in the Name field that helps you to identify the layout template 
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you are about to create, such as “2x2 with 9 small”.

• Reset your current view to one of the pre-configured templates to use as a 
base for your new layout template using Columns and Rows combo-boxes.

• Use white arrows inside the Layout Grid to change the cell's size. 
Tap on any arrow to increase the cell's dimension in the direction of the 
arrow. The new cell will completely take over all cells right next to the arrow. 
Note: You can only enlarge a cell. 

• To start over, use Reset button.

• When you are finished, tap the Add button.

Now, you can select and use your custom layout template from the Layout menu.
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Multiple Cameras

IP Camera Viewer app allows to monitor live video from up to 25 cameras 
simultaneously.

To accommodate large number of cameras, IP Camera Viewer allows you to 
organize your video into separate Video Taps.

To add a new tab, tap the + button and provide a new name for it.

A new tab will appear. 

• By default, the new tab inherits previously selected tab's layout. You can 
always change active layout template for any Video Tabs.

Each cell that displays video has camera name at the top and toolbar at the bottom.
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Toolbar

Each video cell has toolbar for managing video.

To display video toolbar, simply move the mouse into the video cell.

The toolbar automatically appear/disappears every time you move the mouse 
on/away from the video cell. 

The toolbar has following buttons in order of their appearance:

• Camera PTZ  : for controlling Pan, Tilt or Zoom on camera models that support 
PTZ functionality.

• Digital PTZ  : for controlling digital PTZ.

• Full Window Mode  : for displaying video from one camera with max 
dimensions.

• Save Image  : for capturing snapshots from a camera.

• Time Line  : for quick review of recent video activities from a camera.

• Record Movie  : for recording of a small video clips from a camera.

• Close  : for removing a camera from a video cell.
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Camera PTZ

Some IP Cameras models support PTZ functionality: a user can Pan, Tilt or Zoom 
the camera and control PTZ presets.

If PTZ is available for your camera, the app will show an activated PTZ button 
in the main video cell's toolbar. 

The PTZ button is a toggle button. Tap the button to see arrows that control PTZ. 
Tab it again to hide arrows.

In order to start moving in a specific direction, press the arrow button. To stop 
moving, press the button again to release it.

Note: PTZ presets must be configured on the camera before they can be used by 
IP Camera Viewer app.

Note: Camera PTZ functionality is only available when video cell is in the full 
window mode. If the video cell is in the layout mode, activating camera PTZ 
functionality will automatically move the cell into the full screen mode. To return to 
layout mode, tab Full Screen Mode button.
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Digital PTZ

Digital PTZ is available for any camera model.

The app always displays Digital PTZ button in the video cell's toolbar.

The Digital PTZ button is a toggle button. Tap the button to see arrows that control  
Digital PTZ. Tab it again to hide arrows.

In order to start moving in a specific direction, press the arrow button. To stop 
moving, press the button again to release it.

Note: Digital PTZ functionality is only available when video cell is in the full window 
mode. If the video cell is in the layout mode, activating digital PTZ functionality will  
automatically move the cell into the full screen mode. To return to layout mode, tap 
Full Screen Mode button.
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The Full Window Mode

The full window mode displays video from one camera at a time, centering the 
image and making it as large as the window allows.

The app always displays the Full Window Mode button in the video cell's 
toolbar.

The Full Window Mode button is a toggle button. Tap the button to see switch 
between full window and layout modes.

The following functions are available in the full screen mode only.
• PTZ
• Digital PTZ

If the video cell is in the layout mode, activating any of the above  functionality will  
automatically move the cell into the full screen mode. To return to layout mode, tap 
Full Screen Mode button.
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Saving a Snapshot

IP Camera Viewer app allows to save an image from any camera.

The app always displays the Save Image button in the video cell's toolbar.

Tap it to capture the snapshot from the camera. The captured image will be opened 
in Preview app, where you could edit the image, or email it and etc.

IP Camera Viewer automatically manages all exported images. Notice that now the 
camera has ▶ symbol before it in Cameras list control.

Tap it to see Snapshots and Movies from the camera.

All your images will be stored in Snapshots section under the corresponding 
camera.

You can open image any time by tapping on the ▶ button in the middle of the 
snapshot icon. The image will be opened by Preview app.

You can remove any snapshot by selecting it and tapping - button on the lower-left 
corner of the app.
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Scrubbing Live Video

IP Camera Viewer app automatically buffers video for up to 10 minutes for all  
displayed cameras. 

Scrubbing live video functionality allows you to access and instantly replay that 
video from any camera. 

The app always displays the Time Line button in the video cell's toolbar.

The Time Line button is a toggle button. Tap the button to see recently displayed 
video. 

Scrub the images with the mouse to find the desired time.

Note: Every time you are in Time Line mode, the camera's video cell is NOT 
displaying live video.

When you are ready to switch to live video, tap the Time Line button again.
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Recording a Movie Clip

IP Camera Viewer app allows to record a short movie clip from any camera.

The app displays the Record Movie button in the video cell's toolbar.

The Record Movie button is a toggle button. Tap it to start recording a movie clip. 

Notice the red flashing icon in the top left corner of the video cell. It is an indicator  
of video currently being recorded from the camera.

When you are ready to stop recording, tap the Record Movie button again.

The recorded movie clip will be opened by QuickTime Player app. It allows you to 
play back the movie, email it and etc.

Notice that now the camera has ▶ symbol before it in Cameras list control. 

Tap it, it will open into additional section Movies.

All your movies will be listed in Movies section under the corresponding camera.

You can play it by tapping on the ▶ button in the middle of the movie clip video 
icon. The recorded movie clip will be opened by QuickTime Player app. It allows 
you to play back the movie, email it and etc.

You can always remove any movie clip by selecting it and tapping - button on the 
lower-left corner of the app.
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Closing a Video Cell

You can easily stop displaying a camera from any video cell.

The app always displays the Close button in the video cell's toolbar.

Note: Tapping the Close button will only STOP displaying video from the camera. It 
will NOT remove the camera from IP Camera Viewer app.
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Storage

IP Camera Viewer closely monitors your Mac's hard drive. It collects information 
about its capacity, amount of space used for other applications, video recording and 
free space available. It makes decisions on when to remove old video to free space 
for new one.

You can see the summary of the current hard drive status by activating Show 
Storage Info menu item from the Window menu.

The Storage window looks like the following.
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Video Search
IP Camera Viewer app provides Video Search functionality to manage recorded 
video for any recorded camera.

Launching Video Search Window

You can launch Video Search window to search recorded video for any camera that  
has video recording and/or video analytics activated.

Once you have configured video recording on a camera, you can search recorded 
video for events from the camera. For this, select the camera and tap 

• The Camera menu on the top of the computer screen and select Video 
Search item.
or

• The Video Search item from the camera's pop-up menu.
or

• The Search button in the bottom-left corner of the app screen.

IP Camera app will open Video Search window.

If, in addition to video recording, you have configured video analytics you can also 
launch and view video from any event in Events list. For this, select the event from 
Events list and

• Tap on the ▶ button in the middle of the event video icon

IP Camera app will open Video Search window.

Copyright © 2011-2012 DComplex, LLC           38



DComplex IP Camera Viewer User Manual

Functionality Overview

Video Search window contains the following elements

• Toolbar: for navigating the Time Line and video

• Time Line  : for graphical display of recorded video and events

• Video Cell  : for playing recorded video

• Events List  : for showing any events detected from the camera
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Time Line

Video Search window allows you to pick time from Time Line control by tapping 
anywhere on it. 

The Time Line can show video allocation time line in two different time intervals

• One Hour interval

The toolbar will display button. The Time Line control will show 1 hour 
time per line.

• One Day interval

The toolbar will display button. The Time Line control will show 1 day 
time per line.

Use the buttons above to switch between different time interval modes.

Video is graphically marked on the Time Line using green for continuous recorded 
video and red for events.

You can scroll the Time Line all the way down to the first available video. 

Once you have selected the time from the time line, video cell will start video 
playback from that time automatically.

You can navigate between to the closest events next to the selected time by using 
button below.
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Events List

Video Search window allows you to search through all events from the camera,  
and/or export any event or any video clip.

Event list has all events generated from the camera for the time selected in Time 
Line control. You can see the selection as blue rectangle. 

Tapping on any other lines will switch the selection. Every time you do it, the Event 
list will be refilled with updated events from the selected time frame.

Simply selecting an event from Events list will automatically 

• Mark the event position on the time line and

• Start video playback from the event in the video cell control. The video 
playback will play for the duration of the event and then stop automatically.

Video Search window allows instant export of any selected event. 

The window always displays button in its toolbar. 

Tap it to open the configuration window below. 

The event will be opened by QuickTime Player app. It allows you to play back the 
movie, email it and etc.
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Playing Recorded Video

Video Search window allows you to search through all video from the camera.

Once you have selected the time from Time Line control, it start video playback 
from that time automatically.

You have the following controls in the toolbar to help you search recorded video.

Video Search window allows to save an image of recorded video from the camera.

The window always displays the Snapshot button in its toolbar.

Tap it to capture the snapshot of the recorded video. The captured image will be 
opened by Preview app.
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Other IP Camera Viewer Features

E-mailing Technical Support

If you need help with the app, you can use the menu to send an email directly to 
Technical Support. 

This is especially useful when the app generates error messages. The most recent  
error messages will automatically be included in the email for more efficient 
troubleshooting.

If you have any questions or comments about the app, please send email to 
support@dcomplex.com
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